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Process Visualization with the 
SIMATIC HMI Panel KTP700 Basic 
and WinCC Basic  

1 Objective 

In this section, you will become familiar with the basics of process visualization and the use of a 
SIMATIC HMI Panel KTP700 Basic together with SIMATIC S7-1200 and the TIA Portal 
programming tool.  

The module explains the configuring of a SIMATIC HMI Panel KTP700 Basic, the creation of a 
connection to the SIMATIC S7-1200 and the read and write access to CPU data of the SIMATIC 
HMI Panel KTP700 Basic. 

The SIMATIC S7 controllers listed in section 3 SIMATIC S7 controllers can be used. 

2 Requirements 

This module builds on the Global Data Blocks for SIMATIC S7-1200 module. To implement this 
module, you can use the following project, for example:  
"SCE_EN_031-600 Globale_Data_Blocks_S7-1200….zap14". 

 

3 Hardware and software required 

1 Engineering Station: Requirements for hardware and operating system  
 (for additional information, see Readme on the TIA Portal Installation DVD) 

2 SIMATIC STEP 7 Basic software in the TIA Portal V14 SP1 or higher 

3 WinCC Basic software in the TIA Portal V14 SP1 or higher 

4 SIMATIC S7-1200 controller, e.g. CPU 1214C DC/DC/DC with signal board ANALOG 
 OUTPUT SB1232, 1 AO, firmware V4.2.1 or higher  
 
 Note: The digital inputs and the analog inputs and outputs should be fed out to a  
 control panel. 

5 SIMATIC HMI Panel KTP700 Basic 

6 SCALANCE XB005 INDUSTRIAL ETHERNET Switch 

7 Ethernet connection between the engineering station and switch, controller and switch 
 and HMI Panel KTP700 Basic and switch 
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4 Theory 

4.1 Process visualization 

Due to production processes are becoming more and more complex and requirements for 
machine and plant functionality are increasing, operators need a powerful tool for controlling and 
monitoring production plants. An HMI system (human-machine interface) represents the 
interface between man (operator) and process (machine/plant). It is the controller that actually 
controls the process. Hence, there is an interface between the operator and WinCC (at the HMI 
device) and an interface between WinCC and the controller.  

 

The SIMATIC HMI Basic Panels and WinCC perform the following tasks: 

 

• Display processes with a straightforward screen structure 

The process is mapped on the HMI device. The display on the HMI device is updated when a 
process state changes, for example. A process can be displayed in a clearly structured manner 
in multiple screens. 

 

• Communicate with processes 

The operator can communicate with the process via the graphical user interface For example, 
the operator can define a setpoint for the controller or start a motor. 

 

• Output alarms 

When critical process states occur, such as when a specified limit is exceeded, an alarm is 
automatically triggered. 

 

• Archive process values and alarms 

The HMI system can log alarms and process values. In this way, you can document the process 
history. As a result, you can later access older production data. 

 

• Document process values and alarms 

The HMI system can print out alarms and process values as reports. This allows you to output 
production data at the end of a shift, for example. 

 

• Manage process and machine parameters in recipes 

The HMI system can store parameters for processes and machines in recipes. For example, you 
can transfer these parameters from the HMI device to the controller in one step in order to switch 
the production to a different product version. 

 

• User management 

Certain rights can be assigned to the devices, thereby limiting the possible operator inputs for 
particular users. 
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4.2 SIMATIC HMI Panel KTP700 Basic 

4.2.1 Device description 

The SIMATIC HMI Basic Panels product line features key and touch panels (operator input via 
keyboard and touch screen)  

SIMATIC HMI Basic Panels cover all requirements described in the previous section.  

 

These HMI devices are explained in this document using the KTP700 Basic as an example.  

 

Figure 1: KTP700 Basic 

The WinCC Basic (TIA Portal) software is needed for configuration and programming. This 
software is included in the SCE Trainer Package "SIMATIC HMI KTP700 BASIC COLOR 
PANEL for S7-1200"! 

 

Notes: 

– Because all the devices in this product series have similar functionality, it would also be 
possible to implement this section with another product device in this series. 

– The Touch Panel KTP700 Basic can also be displayed on the PC as Runtime simulation with 
WinCC Basic. 
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4.2.2 Design of the KTP700 Basic for PROFINET 

 

 

① Connection for power supply  

② USB interface for USB mass storage device or USB mouse 

③ PROFINET interface 

④ Recesses for a mounting clip 

⑤ Display/touch screen 

⑥ Mounting gasket 

⑦ Function keys 

⑧ Rating plate 

⑨ Connection for functional ground 

⑩ Guide for labeling strip 
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4.2.3 Memory concept 

The HMI devices can use the following memory: 

− Internal memory 

− USB mass storage on USB interface 

 

Internal memory 

The following data is stored here: 

− Operating system 

− Project file 

− License keys 

− User management 

− Recipes 

 

USB mass storage on USB interface 

The following data can be stored here: 

− Operating system for update 

− Project file as backup 

− User management as backup 

− Recipes as backup 

− Recovery software for resetting to factory settings via USB 

− License keys for transfer to the panel 

− Certificates for web-based communication 
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4.2.4 Settings on Touch Panel KTP700 Basic/Start Center 

Several important settings must be made directly on the Touch Panel KTP700 Basic. 

The Touch Panel KTP700 Basic runs with the Windows CE operating system. Similar to all touch 
panels, operator inputs can be made directly on the screen. For better performance, you should 
use a special touch pen or connect a mouse to the panel's USB port. 

After startup of the panel, the 'Start Center' window appears. 

 

Buttons in the Start Center: 

Transfer: Data transfer is activated, and the panel waits for the configuration data to be 
downloaded from WinCC to the PC. "Transfer" mode can only be activated when at least one 
data channel is enabled for the transfer. 

Start: Runtime is started, and the process visualization appears on the panel. Often the panel is 
set in such a way that the start occurs automatically after a few seconds. 

Settings: The Windows CE settings dialog is opened. Settings for the panel can be made here: 
You make various settings on this page, such as settings for the transfer. 

 

→ Select → the "Settings" button in the "Start Center" immediately after switching on the power 
supply and starting the panel. 

 

 

Note:  

– You must select "Settings" in the "Start Center" quickly before Runtime automatically starts. 
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4.2.5 Setting the date and time 

→ Under "System", select the    icon to make the date and time settings. 

 

 

→ Under "Date & Time", set the time zone ("Time shift") and the date and time.  
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4.2.6 Setting the transfer properties and assigning the IP address 

→ Under "Transfer, Network & Internet", select the  icon to navigate to the transfer 

properties. 

 

 

→ Select the following settings for the "Transfer Settings". 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 14 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

→ Under "Transfer, Network & Internet", select the  icon to navigate to the network 

settings. 

 

 

→ In menu item "Interface PN X1", set the IP address under "IP address" and the subnet mask 

under "Subnet mask". 
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4.2.7 Switching off the sound on the touch panel 

→ Under "System", select the  icon to navigate to the sounds settings of the touch 

panel. 

 

 

→ Under "Volume", switch → "Sound" to "OFF". 
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4.2.8 Calibrating the touch panel 

→ Under "Display & Operation", select the  icon to navigate to the calibration of the 

touch panel. 

 

 

→ Select the "Touch" menu item. Start the calibration with → "Recalibrate". 
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→ Touch anywhere on the screen within 15 seconds to start the calibration. 

 

 

→ Follow the instructions on the touch panel and press as close to the center of the displayed 

cross as possible. 
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4.3 WinCC Basic programming software  

The WinCC Basic software is included in the TIA Portal as an integral component of STEP 7 
Basic or STEP 7 Professional and is the programming tool for the following visualization system: 

− SIMATIC Basic Panels 

 

With WinCC Basic you have the following functions for creating HMI systems:  

− Hardware configuration and parameter assignment 

− Specification of communication and creation of a connection to a PLC 

− Creation and layout of screens with hierarchical structure 

− Creation of internal and external tags 

− Creation of alarms and alarm displays 

− Creation and display of logs as trends and in tables 

− Creation of recipes and recipe displays 

− Creation and printing of reports 

− Testing, commissioning and service with operational/diagnostic functions 

− Documentation 
 

All functions are supported by an extensive online help. 
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4.3.1 Project 

For the solution to an automation and visualization task, you create a project in the TIA Portal. A 
project in the TIA Portal contains data on the configuration and networking of devices as well as 
the programs and the configuration of the visualization. 

4.3.2 Hardware configuration 

The hardware configuration contains the configuration devices, consisting of the automation 
system hardware, the field devices on the PROFINET bus system and the hardware for 
visualization. The configuration of the networks specifies the communication between the 
various hardware components. Individual hardware components are inserted from catalogs into 
the hardware configuration. 

The hardware of SIMATIC S7-1200 automation systems consists of the controller (CPU), the 
signal modules for input and output signals (SM), the communication modules (CM) and other 
special modules. 

The signal modules and field devices connect the input and output data of the process to be 
automated and visualized to the automation system. 

The hardware configuration enables automation and visualization solutions to be downloaded to 
the automation system and the controller to have access to the connected signal modules. 
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4.3.3 Planning the hardware 

Before you can configure the hardware, you must plan it. In general, you start by selecting the 
required controllers and the number needed. Next you select the communication modules and 
signal modules. The signal modules are selected based on the number and type of inputs and 
outputs needed. Finally, a power supply must be selected for each controller or each field device 
to ensure the required power is supplied. 

The functionality needed and the environmental conditions are of critical importance for planning 
the hardware configuration. For example, the temperature range in the application area is one of 
the limiting factors for selecting possible devices. Fail-safe capability could be another 
requirement. 

The TIA Selection Tool (select Automation System → TIA Selection Tool and follow the 
instructions) offers you support.  

 

Notes: 

– TIA Selection Tool requires Java 

– Online research: To obtain the device specifications, look for the manual described as 
"Product Manual" or "Manual" among the various manuals listed. 

 

There are centralized and distributed applications available for the visualization. For local, 
distributed operator input, panels are often used. These can communicate with the controller via 
Ethernet, WLAN or fieldbus. For central operator control and monitoring, PC can also be used. 
These are usually connected to the controller via Ethernet. 

The TIA Selection Tool also supports you when selecting panels (select Automation System → 
TIA Selection Tool and follow the instructions). 

 

https://mall.industry.siemens.com/mall/en/WW/Catalog/Configurators
https://mall.industry.siemens.com/mall/en/WW/Catalog/Configurators
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4.3.4 Planning the screen structure 

After selecting a device for the visualization, the screen structure must be planned. To do this, 
you should assemble, group and structure the information to be displayed. From this it should be 
possible to derive a screen structure like the one shown in Figure 2. The entry point to the 
screen structure is always ensured by a "root screen". 

 

Figure 2: Example of screen structure 

The determining factor for the screen structure should be its support of the operator when 
navigating through the information distributed among the screens for operator control and 
monitoring of the process.  

 

The following questions may be helpful: 

What conceptual model of the process must be followed for the information display? 

What data belong together? 

What data belong in a specific sequence? 

What data belong to specific operations/processes? 

Are there data and the like that apply across operations? 

What data represent key information and what data are additional information? 
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4.3.5 Planning of screen design 

Every individual screen must also be planned. Considerations regarding use by the operator are 
also necessary for the information display. It is helpful here to follow design principles such as 
the principles of proximity, similarity and symmetry. The following rules of thumb derived from 
design principles can also support the design of screens: 

→ Form groups of data blocks 

→ Uniform subdivision of the entire screen into work information, status or system information 

and controller information 

→ Observe average distribution of attention on the screen as a function of reading direction 

→ Use compactness as design principle (numbers, column headings same as column content) 

→ Make appropriate use of 30-40 % of available space: Accommodate as little information as 

possible and as much as necessary 

→ Economical coding (for example, color, bold text, lightness, shape, border, appearance, 

flashing) 

→ Organize numbers: organize numbers with more than 4 digits in groups of 2, 3 or 4 (for 

example, 66 234) 

→ Preferably choose numerals in listing of objects, properties, etc. 

→ Use and position designations uniformly 

→ Use short words if possible 
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4.3.6 Basic settings for WinCC Basic in the TIA Portal 

The user can make customized presets for certain settings in the TIA Portal. The method for 
making the settings for the visualization is shown here. 

→ In the Project view, select menu command → "Options" and then → "Settings". 

 

 

→ In the → "Visualization" item of Settings, select the desired presets for the design of the user 

interface. 

 

Note: 

− Keep the default settings as the settings for the visualization here. 
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4.3.7 Resetting the SIMATIC HMI Panel KTP700 and setting the IP address   

The HMI Panel KTP700 Basic can be reset directly in the TIA Portal. A new IP address can also 
be assigned to the panel there. 

To do this, select the Totally Integrated Automation Portal, which is opened by a double-click.  

(→ TIA Portal V14)  

 

→ Click the → "Online & Diagnostics" item and open the → "Project view". 
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→ In the project tree, select the network adapter of your computer under → "Online access". 

When you click → "Update accessible devices", you see the IP address (if already set) or the 

MAC address (if the IP address has not yet been assigned) of the connected SIMATIC HMI 

Panel → Click → "Online & diagnostics".  
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→ To assign the IP address, select the → "Assign IP address" function. For example, enter the 

following IP address and subnet mask here: → IP address: 192.168.0.10 → Subnet mask: 

255.255.255.0. Next, click → "Assign IP address". The new address is assigned to your 

SIMATIC HMI Panel KTP700 Basic.  

 

 

→ The successful (or unsuccessful) assignment of the IP address is shown as a message in the 

→ "Info" window, → "General" tab. 

 

 

Note: 

– If there are problems assigning the IP address, the IP address of the SIMATIC HMI Panel 
KTP700 Basic can also be set via Windows CE of the panel. 
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4.3.8 WinCC user interface  

 

 

 

 

 

 

 

 

 

 

 

Project tree Menu bar and buttons 

Details view Properties window 

Toolbox Work area 
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4.3.9 Project tree 

The project tree is the central control point for the project handling. All component parts and all 
the available editors of a project are displayed in a tree structure in the project window and can 
be opened from there.  

Each editor is assigned a symbol which you can use to identify the corresponding objects. Only 
elements that are supported by the selected HMI device are displayed in the project window. 

In the project window, you have access to the device settings of the HMI device. 

 

 

4.3.10 Details view 

The Details view shows the contents or other information on the objects selected in the project 
tree. 
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4.3.11 Menu bar and buttons 

The menus and toolbars provide access to all functions you need to configure your HMI device. 
When a corresponding editor is active, editor-specific menu commands and toolbars are visible. 

When the mouse pointer is moved over a command, you receive a corresponding tooltip for 
each function. 

 

 

4.3.12 Work area 

You edit the objects of the project in the work area. All other elements of WinCC are arranged on 
the borders of the work area.  

Project data can also be edited here either in tabular form (e.g. tags) or graphically (e.g. process 
screens).  

A toolbar is located at the top of the work area. For example, you can select formatting such as 
font and font color and functions such as rotate, align, etc. here. 
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4.3.13 Toolbox 

In the toolbox window, you will find a selection of objects that you can insert in your screens, e.g. 
graphic objects and operator controls. In addition, the toolbox window also contains libraries with 
ready-made graphic objects and collections of faceplates. 

The objects are moved to the work area using drag & drop. 
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4.3.14 Properties window 

In the properties window, you edit the properties of the objects selected in the work area, e.g. 
the color of screen objects. The window is only available in specific editors. 

The properties window also shows the properties of the selected object, organized by category. 
The changed values take effect as soon as the input field is exited. If you enter an invalid value, 
it is highlighted in color. The tooltip gives you information about the valid value range, for 
example. 

Animations (e.g. color change at a change of signal state in the PLC) and events (e.g. screen 
change when a button is released) are also configured for a selected object in the properties 
window. Multilingual texts can also be managed here. 
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4.3.15 Additional tabs 

The settings of the work area, such as the layer selection and the grid functions, can be made in 
the "Layout" window. 

Animations, instructions, tasks and libraries of the selected object can be selected via other tabs. 
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5 Task  

In this section, a process visualization is to be added to the program from section 
"SCE_EN_031-600 Global Data Blocks for S7-1200". This enables you to better monitor and 
process flow and control it more effectively. 

6 Process visualization planning 

A Touch Panel KTP700 Basic is to be used for the process visualization. 

The programming device, a SIMATIC S7-1200 controller and the Touch Panel KTP700 Basic are 
connected to one another via the Ethernet interface using a SCALANCE XB005 UNMANAGED 
INDUSTRIAL ETHERNET SWITCH. 

The wizard in the TIA Portal is to be used for the basic configuring. In doing this, all system 
screens are also to be created. 

The process will be represented with the conveyor and sensors in an "Overview Sorting 
Station" overview screen. Conveyor speed and the plastic parts count will also be displayed 
here. 

This operator is to be able to select the operating mode, start and stop in automatic mode and 
reset the counter in this screen. 

 

In an additional "Speed Motor" screen, the actual speed of the motor will be graphically 
displayed. The speed setpoint can also be specified here. 

 

The "Magazine Plastic" screen will be initially only created. 

 

The screen name, date/time and system states "Emergency stop ok/released", "Main switch 
ON/OFF" and "Automatic started/stopped" are displayed in the header. 

 

The footer has a button for returning to the root screen, a button for displaying the alarm window 
and a button for ending Runtime mode. 

 

The alarm system is also to be configured.  

 

System events of the panel are to be displayed as alarms and motor speed limit violations of the 
main switch are to be monitored. 

In doing so, the alarms are automatically displayed in alarm windows when errors/warnings 
occur.  
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6.1 Program description for the sorting station with motor speed 
control and monitoring 

The "MOTOR_AUTO" [FB1] function block controls a conveyor in automatic mode. 

The Memory_Automatic_Start_Stop is switched on in a latching manner with Start, but only if the 
reset conditions are not present. 

The Memory_Automatic_Start_Stop is to be reset if Stop is pending, the safety shutoff is active 
or automatic mode is not activated from the visualization. 

The Automatic_Motor output is controlled when Memory_Automatic_Start_Stop is set, the 
enabling conditions are met and Memory_Conveyor_Start_Stop is set. 

For energy saving reasons, the conveyor is to run only when a transport part is present. 
Therefore, Memory_Conveyor_Start_Stop is set if Sensor_slide signals a part and is reset if 
Sensor_end_of_conveyor generates a negative edge, or the safety shutoff is active or automatic 
mode is not activated (manual mode). 

Because Sensor_end_of_conveyor is not mounted directly at the end of the conveyor, a signal 
delay of the Sensor_end_of_conveyor signal is programmed. 

The magazine for plastics holds only five parts. Therefore, the parts are counted at the end of 
the conveyor. If the magazine contains five parts, automatic mode is to be stopped. After the 
magazine is emptied, automatic mode is restarted with another Start, once the counter has been 
reset from the visualization. 

The speed is specified with an input in the "MOTOR_SPEEDCONTROL" [FC10] function in 
revolutions per minute (range: +/- 50 rpm).  

The speed setpoint is first checked in the function for correct input in the range +/- 50 rpm. 

If the speed setpoint is outside the range +/- 50 rpm, the value 0 is output at the speed setpoint 
output. The value TRUE (1) is assigned to the return value of the function (Ret_Val). 

If the specified speed is in the range +/- 50 rpm, this value is first scaled to the range 0…1 and 
then scaled for the output as manipulated speed value at the analog output to +/- 27648 with 
data type 16-bit integer (Int). 
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In the "MOTOR_SPEED_MONITORING" [FC11] function, the actual value is made available at -
B8 as an analog value and is queried at an input of the "MOTOR_SPEEDMONITORING" [FC11] 
function.  

The actual speed value is scaled to revolutions per minute (range: +/- 50 rpm) and made 
available at an output. 

The following four limits can be specified at the block inputs in order to monitor them in the 
function: 

Speed > Speed limit error max 

Speed > Speed limit warning max 

Speed < Speed limit warning min 

Speed < Speed limit warning min 

 

If a limit is exceeded or undershot, the value TRUE (1) is assigned to the corresponding output 
bit. 

If a fault is present, the safety shutoff of the "MOTOR_AUTO" [FB1] function block is to be 
triggered. 

 

Speed setpoint and actual speed value as well as the positive and negative error and warning 
limits are created in the "SPEED_MOTOR" [DB2] data block, as are the error and warning bits. 

 

The setpoint and actual value of the counter for plastic parts will be specified and displayed in 
the global "MAGAZINE_PLASTIC" [DB3] data block. These values are connected with the 
"MOTOR_AUTO" [FB1] function block via an input for specification of the setpoint and via an 
output for display of the actual value. 
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6.2 Technology schematic diagram 

 

Here you see the technology schematic diagram of the system for the task. 

 

Figure 3: Technology schematic diagram 

 

Figure 4: Operator panel 
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6.3 Reference table 

The following signals are required as global operands for this task. 

DI Type ID Function NC/NO 

I 0.0 BOOL -A1 Return signal emergency stop ok NC 

I 0.1 BOOL -K0 Main switch "ON" NO 

I 0.2 BOOL -S0 Mode selector manual (0) / automatic (1) 
Manual = 0 

Auto=1 

I 0.3 BOOL -S1 "Automatic start" pushbutton NO 

I 0.4 BOOL -S2 "Automatic stop" pushbutton NC 

I 0.5 BOOL -B1 Sensor cylinder -M4 retracted NO 

I 1.0 BOOL -B4 Sensor part at slide NO 

I 1.3 BOOL -B7 Sensor part at end of conveyor NO 

IW64 BOOL -B8 
Sensor actual motor speed +/-10V 
corresponds to +/- 50 rpm 

 

 

DO Type ID Function  

Q 0.2 BOOL -Q3 Conveyor motor -M1 variable speed  

QW 64 BOOL -U1 
Motor speed manipulated variable in both 
directions +/-10V corresponds to +/- 50 rpm 

 

 

 

Legend for reference list 

 

 

 

 

 

 

 

 

DO Digital output 

AO Analog output 

O Output 

DI Digital input 

AI Analog input 

I Input 

NC Normally Closed 

NO Normally Open 
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7 Structured step-by-step instructions 

Here you will find an example of instructions for the planning task. If you already have a good 
understanding of everything, it is sufficient to focus on the numbered steps. Otherwise, follow the 
step-by-step instructions below. 

7.1 Retrieving an existing project 

→ Before you can expand the "SCE_EN_031-600 Global_Data_Blocks_S7-1200…..zap14" 

project from section "SCE_DE_031-600 Global Data Blocks for S7-1200", you must retrieve 

it. To retrieve an existing project, you must select the respective archive from the Project view 

below → Project → Retrieve. Confirm your selection with Open.  

(→ Project → Retrieve → Selection of a .zap archive … → Open) 

 

 

→ Next, the target directory in which the retrieved project is to be stored can be selected. 

Confirm your selection with "OK". (→ Target directory … → OK) 
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→ You save the opened project under the name 041-101_WinCC_Basic_KTP700_S7-1200.  

(→ Save → project as … → 041-101_WinCC_Basic_KTP700_S7-1200 → Save) 

 

 

7.2 Adding SIMATIC HMI Panel KTP700 Basic 

→ To create a new panel in the project, switch to the Portal view. Select menu item → "Devices 

& Networks" and → "Add new device" in the Portal. 
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→ Next, select → "HMI" → "SIMATIC Basic Panel" → "7” Display" → "KTP700 Basic" as the 

device variant and the correct order number of your panel; here, e.g. → 6AV2 123-2GB03-

0AX0. 

 

→ Enter the device name Panel KTP700 Basic and → select the  "Start device wizard" check 

box. Click the  button. 
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7.3 HMI device wizard for Panel KTP700 Basic 

The TIA Portal creates the desired panel and automatically starts the HMI device wizard for 
Panel KTP700 Basic. This supports you in specifying some basic settings and functions for the 
panel. 

→ You are first prompted for the PLC connections. Select your previously configured  

CPU 1214C as the communication partner. 

 

 

→ In order to connect your panel to the CPU, select the "PROFINET(X1)" interface.  

→ Confirm your selection by clicking on " ". 
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→ You can change the default background color of your panel under "Screen layout".  

→ Select the  "Header",  "Date/time" and  "Logo" check boxes. → Confirm your 

selection by clicking on " ". 

 

→ In the "Alarms" section, you can specify which of the alarms are to be displayed in a window. 

Select all three alarm types  → Confirm your selection by clicking on  

" ". 
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→ In the "Screen navigation" section, the screen structure is displayed with the screen name of 

the last created project, starting with the root screen on the far left. 

→ A new name can be assigned simply by clicking on a screen name. → If you click on  

you can insert new screens in the hierarchy → and delete selected screens by clicking on "

". 

 

 

→ Use this approach to create the screen structure shown below with the corresponding screen 

names.→ Confirm your selection by clicking on " ". 
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→ In the System screens section, you can select previously preset views for system functions 

and have them automatically added. → Select all system screens by clicking  "Select all". 

→ Confirm your selection by clicking on " ". 
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→ In the System buttons section, you will find four user-selectable buttons for Exit  

(Runtime), Log on , Language  and Root screen . You can place these buttons on 

the provided button areas "Left", "Bottom" or "Right" as desired. An "Open alarm window" 

button  is already created. 
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→ Select only the "Button area"  "Bottom". → Insert the button for the "Root screen"  on 

the left and the button for "Exit" Runtime  on the right. → Confirm your selection by 

clicking on " ". 
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7.4 Device configuration of Panel KTP700 Basic 

→ The TIA Portal now automatically changes to the Project view and displays the root screen of 

the visualization. 

 

→ To configure the panel, select "Panel KTP700 Basic" in the project tree and open its "Device 

configuration" with a double-click. 
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7.4.1 Setting the IP address 

→ Select the Ethernet interface of the panel in the Device view with a double-click.  

→ Under "General" in → "Properties", open menu item → "PROFINET interface [X1]" and select 

in the → "Ethernet addresses" entry.  

→ Set the IP address "192.168.0.10" under IP protocol. 

 

Note: 

– The subnet mask was already set in the settings of the CPU 1214C and is automatically 
applied by the panel. 

→ To obtain an overview of the assigned addresses within a project, you can click the  

→ " " button in the → "Network view". If you click on →  here, the "HMI 

connection" between the CPU and panel that was created previously in the wizard is 

displayed.  

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 49 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

7.5 Compiling the CPU and panel and saving the project  

→ To compile the CPU, click on the "CPU_1214C" folder, and select the  button for 

compiling in the menu. To compile the panel, click on the "Panel KTP700 Basic" folder, and 

select the  button for compiling in the menu. You can save your project by clicking on the 

 button in the menu.  

(→ CPU_1214C →  → Panel KTP700 Basic → → ). 

 

 

→ In the "Info" area under "Compile", it is then shown whether the compilation was successful 

or whether warnings or errors occurred. 
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7.6 Configuring the Graphic view 

→ After successful compilation, you want to design the first screen for the visualization. To do 

this, open the → "Overview Sorting Station" screen with a double-click: 
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→ Several objects, such as the screen change buttons, have already been created by the 

wizard. The text box in the center of the screen is to be removed by right-clicking on it and 

selecting → "Delete" in the displayed dialog. 
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→ Select → "Graphic view"  from → "Basic objects" in Toolbox. The mouse pointer changes 

in such a way that it can now be used to draw an area for the display of a graphic in the work 

window. 
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→ You can double-click on the area of the Graphic view to have its properties displayed. In sub-

item → "General", select → the symbol for →  "Create new graphic from file". 

 

 

Note:  

– There are four sub-items for the properties of objects: 

− Properties for static settings of the object 

− Animation for dynamic settings of the object 

− Events when actions are to be triggered from an object 

− Texts for multilingual display within an object 
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→ In the displayed dialog, select the "Foerderband_Conveyor.bmp" file from the "SCE_EN_041-

101_Screens" folder and click → "Open". 

 

 

Note: 

– You can draw the graphics used in this document yourself and save them in *.bmp format or 
download them from the Internet at siemens.com/sce/S7-1200 in module "SCE_EN_041-101 
WinCC Basic with KTP700 and S7-1200" under "SCE_EN_041-101_Screens". 

 

→ For the display, select the "Foerderband_Conveyor.bmp" graphic and click → "Apply". 

 

 

Note: 

– The created graphic is stored in the project in the "Languages & resources" path under 
"Graphic collection". 

http://www.siemens.com/sce/S7-1200
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→ Use the mouse to position the graphic in such a way that the positions and sizes indicated 

below are entered → under "Layout" in → Properties. The → "Fit graphic to object size" 

option can be used for adjusting the size. 
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7.7 Displaying a process value in an IO field 

→ First, insert a display of the actual value of the current speed below the conveyor motor. 

For this, select → "Program blocks" and the → "SPEED_MOTOR[DB2]" data block of 

→ "CPU_1214C". Next, move the → "Speed_Actual_Value" tag from the → Details view to 

the "Overview Sorting Station" screen using drag & drop. 
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→ The connection to the tag in the PLC is already created in "Properties" of the IO field under 

"General" and "Process". The "Display format" is correctly set to "Decimal". Only the "Format 

pattern" and the "Type" of the field are changed here to → "s999.99" and → "Output", 

respectively. 

 

 

Note: 

– The format pattern s999.99 means that the IO field is displayed with three places before 
decimal, two places after the decimal and a sign. 

 

→ The "Color" of "Background" is changed to → "Blue" under "Appearance" in "Properties". 
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→ Under "Text format" in "Properties", change "Alignment" "Horizontal" to → "Right". 

 

 

→ Under "Layout" in "Properties", you change → "Position & size" as illustrated here so that the 

IO field is displayed below the conveyor motor. 

 

 

→ For the description, you insert a → "Text field"  from → "Basic objects" of Toolbox after 

the IO field using drag & drop. Type in the texts → "Speed actual value" and → "rpm". 
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→ Select the three objects → IO field → text field "Speed actual value" → text field "rpm" in this 

order and click on the → "Align selected objects on top"  function in the toolbar of the work 

area. Save your project by clicking on . 

 

 

7.8 Visualizing binary signals with animated rectangles/lines 

→ For visualization of the sensors, start with sensor "-B4" at the slide. To enable you to better 

draw and position the rectangle, change the zoom factor to → "300%". 
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→ Then, use drag & drop to move a "Rectangle"  from → "Basic objects" of Toolbox to the 

position of sensor "-B4". 

 

→ Next, use the mouse to change the rectangle to the appropriate position and size or set the 

→ "Position & size" under "Layout" in "Properties" as shown here. As a result, the sensor is 

displayed below the "-B4" label. 

 

→ Under "Appearance" in "Properties", change the "Color" of "Background" to → "Gray" and the 

"Width" of "Border" to → "0". 
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→ Now switch to the "Animations" tab, select "Display" and click →  "Add new animation".  

 

→ In the displayed dialog, select → "Appearance" and click → "OK". 

 

→ To establish the connection to the global tag in the CPU, select → "PLC tags" and → "Tag 

table_sorting station" below → "CPU_1214C". Next, move the → "-B4" tag from the Details 

view to the "Name" field for the tag using drag & drop. 
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→ Under "Appearance" in "Display", add a range with value → "1" (signal state "High") and 

change the "Background color" to → "Green". 
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→ Next, use the steps shown previously to create a display for sensors → "-B1", → "-B2", → "-

B5", → "-B6" and → "-B7". 

→ Insert an additional binary display below motor M1 and connect it to the global tag → "-B3". 

For the description, insert a text field → "-B3 Motor active" in front. 
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→ In order to display that the conveyor is being controlled, drag the "Line" object from → "Basic 

objects" of Toolbox onto the conveyor. 

 

 

→ Under "Appearance" in "Properties", change "Style" of the line to → "Solid" and "Color" of 

"Foreground" to → "Green". Change the "Line ends" at "Start" and "End" to "Arrow". 
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→ Now switch to the "Animations" tab, select "Display" and click →  "Add new animation". 

 

 

→ In the displayed dialog, select → "Visibility" and click → "OK". 
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→ To establish the connection to the global tag in the CPU, select → "PLC tags" and → "Tag 

table_sorting station" below → "CPU_1214C". Next, drag the → "-Q3" tag from the Details 

view to the "Tag" field. In addition for the type of evaluation, select → "Range", enter "From" 

→ 1 "To" → 1 and select → "Visible" for "Visibility". 

 

 

→ Copy the arrow from the symbol library with all its properties using →  "Copy" and  

"Paste". 
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7.9 Connections and HMI tags 

→ Before you download the configuration to the Panel KTP700 Basic, you should check the 

connection to the CPU 1214C. To do this, double-click → "Connections" in → "Panel KTP700 

Basic". In the displayed view, you can check the IP addresses and connection settings again. 

It is also important that the  Online check box is selected for the connection. 

 

Note: 

– If access protection has been enabled for the CPU 1214C, the access password can also be 
entered for the panel here. 

 

→ To go to the HMI tags, you must double-click the → "Default tag table" in the → "HMI tags" 

folder below → "Panel KTP700 Basic". All tags that were created with drag & drop have been 

entered here. 
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→ In the default tag table, you can check which tags are being accessed in the CPU 1214C. 

You can also make other settings.   

The "Acquisition cycle" of the tags is to be accelerated from 1 second to 100 milliseconds. 

For this, click on the →  selection field and double-click a new acquisition cycle → "100 

ms" to select it. 

 

→ You can make the settings of other tags using the "Auto complete" function by selecting the 

bottom right corner of the first entry with the mouse and dragging over the other entries. 
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7.10 Downloading the CPU and panel  

→ Before the project is downloaded to the CPU and the panel, compile the CPU and panel 

again and save the project.  

(→ CPU_1214C →  → Panel KTP700 Basic →  → ) 

→ After successful compilation, the entire controller with the created program including the 

hardware configuration, as previously described in earlier modules, can be downloaded.  

(→ ) 
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→ To download the visualization to the panel, follow the same procedure. Select the 

→ "Panel KTP700 Basic [KTP700 Basic PN]" folder and click the →  "Download to device" 

button.  
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→ The manager for configuration of connection properties (Extended download) opens. First, 

the interface must be correctly selected. This is done in three steps: 

→ Type of the PG/PC interface → PN/IE  

→ PG/PC interface → here, e.g. Intel(R) Ethernet Connection I219-LM 

→ Connection to interface/subnet → "PN/IE_1" 

The field → "Show all compatible devices" must be selected and the search for devices in the 

network must be started by clicking the →  button. 
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→ If your panel is displayed in the "Compatible devices in target subnet" list, it must be selected, 

and the download must be started.  

(→ Device type SIMATIC HMI → " ") 

 

→ You first receive a preview. Confirm the prompt → "Overwrite all" and continue with →  

" ". 

 

Note: 

– In the "Load preview", you should see the  symbol in each line, in which actions will be 
performed. You will see additional information in the "Message" column. 
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7.11 Testing the process visualization in the simulation  

So that a connection can be established between the Runtime Simulation on the PG/PC and the 
S7-1200 CPU, the PG/PC interface must first be set to TCP/IP. 

No. Procedure: 

1 Open the Control Panel  

• Using "Start > Control Panel" 

• Or using "Start > Settings > Control Panel" 
(in the classical start menu as in earlier Windows versions) 

2 Double-click the "Set PG/PC interface" icon in the Control Panel.  

                        

3 On the "Access Path" tab, set the following parameters:  

1. For "Access Point of the Application", select S7ONLINE (STEP 7).  
2. From the "Interface Parameter Assignment Used" list, select the 

interface "TCP/IP(Auto) -> with your network adapter that is connected 
directly to the panel and controller, e.g. Intel® Ethernet Connection.  

3. Click OK and confirm the subsequent prompt with OK. 
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→ Select "Panel KTP700 Basic" and click the →  "Start simulation" button. 

 

→ The process visualization is performed on the PC in its entirety with connection to the 

process data in the CPU 1214C. To close the simulation, you can select the →  button 

for "End Runtime" or close the window by clicking on → " ". 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 75 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

7.12 Switches and buttons for process operation 

→ To have an interface for process operation available in the PLC, select → "Add new block" in 

the "Program blocks" folder below "CPU_1214C" and create a global data block  

"OPERATING_HMI". 

 

 

→ In the "OPERATING_HMI" data block, create four tags of data type Bool: → "mode_selector", 

→ "automatic_start", → "automatic_stop" and → "reset_counter_plastic". The start value of 

the "automatic_stop" is also preassigned with → "true". 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 76 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

→ The "MOTOR_AUTO[FB1]" function block is now expanded to include an input tag → 

"Reset_Counter_Workpieces_Plastic" of type → "Bool". This tag is move onto the → "R" 

input of the "CTUD" counter in Network 2 using drag & drop. 

 

 

→ Next, the call of the "MOTOR_AUTO[FB1]" function block must be updated in the 

"Main[OB1]" block. This is done by clicking the → "Update inconsistent block calls"  

button . 
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→ In Network 3 of the "Main[OB1]" block, drag an → "OR" in front of input tag → "Start". 

 

 

→ The second free input of the → "OR" is connected to the → "automatic_start" tag from data 

block "OPERATING_HMI". 
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→ In Network 3 of the "Main[OB1]" block, drag an → "AND" in front of input tag → "Stop". 

 

 

→ The second free input of the → "AND" is connected to the → "automatic_stop" tag from data 

block "OPERATING_HMI". 
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→ The input tag → "Automatic_mode_active" is connected to the → "mode_selector" tag from 

data block "OPERATING_HMI". 

 

 

→ The input tag → "Reset_Counter_Workpieces_Plastic" is connected to the → 

"reset_counter_plastic" tag from data block "OPERATING_HMI". 

 

→ Compile the CPU again and save the project. 

(→ CPU_1214C →  → ) 

→ Download the changed program including the hardware configuration to the CPU 1214C. 

(→ ) 
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→ To implement a pushbutton that resets the workpiece counter for the plastic parts, use  

drag & drop to move the → "Button" object  from → "Elements" in Toolbox to the 

"Overview Sorting Station" screen below the plastic parts storage. 

 

 

→ Under "General" in "Properties", enter → "Reset" for "Label". 

 

 

→ Under "Appearance" in "Properties", change the fill pattern to "Solid" and "Color" of 

"Background" to → "Blue". 
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→ The functionality must also be configured as a pushbutton. To do this, go to the "Events" 

menu, select the → "Press" event and → "<Add function>". 

 

 

→ Under "System functions", select "Edit bits" and → "SetBitWhileKeyPressed" as the function. 
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→ For the process connection, select → "Program blocks" and the → "OPERATING_HMI[DB4]" 

data block of → "CPU_1214C". Next, drag the → "reset_counter_plastic" tag from the → 

Details view to the "Tag (input/output)" field. 
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→ As previously shown in the document, insert a text → "Counter workpieces plastic" above the 

button and a display of the → "actual_plastic_parts" tag from the 

"MAGAZINE_PLASTIC[DB3]“ block to the left of the button. 

 

 

→ To implement the button, use drag & drop to move the → "Button" object  from → 

"Elements" in Toolbox to the top next to the buttons for the screen change. 
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→ Under "General" in "Properties", change "Mode" to → "Graphics and text". Click the symbol to 

open the selection dialog for the → "Graphic when button is not pressed". 

 

 

→ Next, click the symbol for "Create graphic from file"  and double-click the "Pushbutton-

Round-G_Off_256c.bmp" file in the "SCE_EN_041-101_Screens" folder in the displayed 

dialog. 
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→ Similarly, select the "Pushbutton-Round-G_On_256c.bmp" file in the "SCE_EN_041-

101_Screens" folder for the "Graphic when button is pressed". 

 

Note: 

– The created graphics are stored in the project in the "Languages & resources" path under 
"Graphic collection". 

 

→ Under "Layout" in "Properties", change the size of the button under → "Position & size". 

 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 86 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

→ The functionality as a pushbutton is implemented again as a → "Press" event with "System 

function" → "SetBitWhileKeyPressed".  

The → "automatic_start" tag from the → "OPERATING_HMI[DB4]" data block is used for the 

process connection. 

 

→ Next, a "button" for the Stop pushbutton is inserted, as shown in the last steps.  

The "Pushbutton-Stop_Off_256c.bmp" and "Pushbutton-Stop_On_256c" files in the 

"SCE_EN_041-101_Screens" folder are used as graphics.  
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→ The functionality as a "normally closed" pushbutton is implemented here with two events. The 

first event is the → "Press" event with "System function" → "ResetBit" and the second event 

is the → "Release" event with "System function" → "SetBit". In both cases, the → 

"automatic_stop" tag from the → "OPERATING_HMI[DB4]" data block is used for the process 

connection. 
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→ To implement the mode selector, use drag & drop to move the → "Switch" object  from → 

"Elements" in Toolbox to the top between the buttons for the screen change and the Start 

pushbutton. 

 

 

→ Under "General" in "Properties", enter the texts → "Auto" for the "ON" state and → "Man" for 

the "OFF" state. The → "mode_selector" tag from the → "OPERATING_HMI[DB4]" data 

block is used for the process connection. 
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→ Under "Layout" in "Properties", change the size of the mode selector under → "Position & 

size". 

 

 

→ Compile the panel and save the project. (→ Panel KTP700 Basic →  → ) 

→ Download the modified visualization to the panel. (→ ) 
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7.13 Changing the header and footer in the template 

→ The plant states should be displayed universally in the header. "Template_1" was created for 

the header and footer by the wizard when the panel was created. The footer contains the 

system buttons. The logo, date and time and the symbolic IO field for selection and display of 

screens have already been created in the header.  

→ First, the "Symbolic_IO_Field_Screen" is changed to the size specified here under "Layout" in 

"Properties" in → "Position & size". 

 

 

→ Delete the logo on the left side of the header by right-clicking the → Graphic view for the 

LOGO and clicking → "Delete". 
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→ Open the → "Text and graphic lists" folder below "Panel KTP700 Basic". 

 

 

→ Under "Graphic lists", create an additional → "Graphic_list_warning" with → Selection "Bit 

(0,1)".  
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→ Click the symbol  next to "Value 0" to open the selection dialog for the graphics stored in 

the "Graphic collection" in the "Languages & resources" path. Next, click the symbol for 

"Create graphic from file"  and double-click the "Warning.bmp" file in the "SCE_EN_041-

101_Screens" folder in the displayed dialog. This file is now stored in the "Languages & 

resources" path under "Graphic collection". 
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→ The graphic that you want to assign to "Value 1" is already stored in the "Languages & 

resources" path under "Graphic collection". After you click the →  symbol, you can select 

the → "Logo of Panel KTP700 Basic" file directly here. 

 

 

→ Change to the "Text lists" and create three text lists → "Text_list_emergency_stop" → 

"Text_list_main_switch" and → "Text_list_automatic", each with → Selection "Bit (0,1)".  
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→ Specify the following assignments in "Text_list_emergency_stop": "Value 0" → "emergency 

stop released" and → "Value 1" → "emergency stop OK". 

 

 

→ Specify the desired assignments in "Text_list_main_switch". "Value 0" → "main switch OFF" 

and → "Value 1" → "main switch ON". 

 

 

→ Specify the following assignments in "Text_list_automatic". "Value 0" → "automatic stopped" 

and → "Value 1" → "automatic started" 
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→ Back in "Template_1" for the header, use drag & drop to move the → "Graphic IO field" 

object  from → "Elements" in Toolbox to the upper left corner. 

 

 

→ Under "General" in "Properties", change "Mode" to → "Output".   

Click the symbol  to open the selection dialog for the → "Graphic list" and select the 

"Graphic_list_warning" you just created. 
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→ To establish the connection to the global tag in the CPU, select → "PLC tags" and → "Tag 

table_sorting station" below → "CPU_1214C". Next, move the  

→ "-A1" tag from the "Details view" to the "Tag" field. Also select → "Bit number 0". 

 

 

→ Under "Layout" in "Properties", change the size of the "Graphic IO field" under → "Position & 

size". 
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→ To display the Emergency Stop status in the header as text, use drag & drop to move the → 

"Symbolic IO field" object  from → "Elements" in Toolbox to the right of the "Graphic IO 

field". 

 

 

→ Under "General" in "Properties", change "Mode" to → "Output". Click the symbol  to open 

the selection dialog for the → "Text list" and select the "Text_list_emergency_stop" you just 

created. 
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→ To establish the connection to the global tag in the CPU, select → "PLC tags" and → "Tag 

table_sorting station" below → "CPU_1214C". Next, move the → "-A1" tag from the "Details 

view" to the "Tag" field and also select → "Bit number 0". 

 

→ Under "Layout" in "Properties", change the size of the "Graphic IO field" under → "Position & 

size". 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 99 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

→ Repeat the previous steps for the text lists → "Text_list_main_switch" and → "Text 

list_automatic" to insert them directly one below the other to the left of the date and time. 

Change the size and font so that the text has enough space. 

→ The connection of the "Text_list_main_switch" is made using the → "-K0" tag from the "Tag 

table_sorting station".  

 

 

→ The connection of the "Text_list_automatic" is made using the →  

"Memory_Automatic_Start_Stop" tag from "MOTOR_AUTO_DB1[DB1]".  

 

 

→ Under "Appearance" in "Properties", change the "Color" of "Background" to → "Gray" for → 

"Text_list_main_switch" and → "Text_list_automatic". 
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→ Now switch to the "Animations" tab for → "Text_list_main_switch" and  

→ "Text_list_automatic", select "Display" and click → "Add new animation".  

 

 

→ In the displayed dialog, select → "Appearance" and click → "OK". 

 

 

→ Under "Appearance" of both "Symbolic IO fields", add a range with value → "1" (signal state 

"High") and change the "Background color" to → "Green". 
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→ The connection of the "Text_list_main_switch" is made again using the → "-K0" tag from the 

"Tag table_sorting station". 

 

 

→ The connection of the "Text_list_automatic" is made using the  

→ "Memory_Automatic_Start_Stop" tag from "MOTOR_AUTO_DB1[DB1]".  
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→ The "Acquisition cycle" of all tags is also to be accelerated from 1 second to 100 milliseconds 

in the default tag table.  

 

 

→ Before the visualization is downloaded to the panel, compile the CPU and panel again and 

save the project. (→ CPU_1214C →  → Panel KTP700 Basic → → ) 

→ After successful compilation, the entire controller with the created program including the 

hardware configuration, as previously described in earlier modules, can be downloaded. 

(→ ) 

→ To download the visualization to the panel, follow the same procedure. Select the → 

"Panel KTP700 Basic [KTP700 Basic]" folder and click the  

→  "Download to device" button.  
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7.14 Bar graph display  

→ Next, the setpoint is to be specified for the motor speed control and the actual value is to be 

displayed. To do this, open the → "Speed Motor" screen with a double-click. 

 

 

→ The text box in the center of the screen is to be removed by right-clicking on it and selecting 

→ "Delete" in the displayed dialog. 
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→ To display the actual speed value graphically, use drag & drop to move the → "Bar graph" 

object  from → "Elements" in Toolbox to the middle of the screen. 

 

 

→ Under "General" in "Properties", change "Maximum scale value" to → 50 and "Minimum scale 

value" to → -50.  
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→ For the process connection, select → "Program blocks" and the → "SPEED_MOTOR[DB2]" 

data block below → "CPU_1214C". Next, drag the → "Speed_Actual_Value" tag from the → 

Details view to the "Process tag" field. 

 

 

→ Under "Scales" in "Properties", select →  "Show scale" and set "Divisions" → 2, "Marks 

label" → 1 and "Interval" → 10. 
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→ Under "Label" in "Properties", select →  "Label" and set "Unit"→ rpm and "Decimal places" 

→ 2. 

 

 

→ Under "Layout" in "Properties", change the position and size of the bar graph under → 

"Position & size". Above the bar graph, insert a → "Text field"  with text → "Speed actual 

value" for the description. 
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→ To enable the speed setpoint to be specified, use drag & drop to move the → "IO field" object 

 from → "Elements" in Toolbox to the right of the bar graph. 

 

 

→ Under "General" in "Properties", keep "Type" → "Input/Output" and change the "Format 

pattern" to → s99.99.  
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→ For the process connection, select → "Program blocks" and the → "SPEED_MOTOR[DB2]" 

data block below → "CPU_1214C".   

Next, drag the → "Speed_Setpoint" tag from the → Details view to the "Tag" field. 

 

 

→ Under "Appearance" in "Properties", change the "Color" of "Background" to → "Blue". 
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→ Under "Text format" in "Properties", change "Alignment" "Horizontal" to → "Right". 

 

 

→ Under "Layout" in "Properties", change the position and size of the IO field under → "Position 

& size". 

→ Above the bar graph, insert a → "Text field"  with text → "Speed setpoint" for the 

description. 
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→ The "Acquisition cycle" of the newly create tag is also to be changed from 1 second to 100 

milliseconds in the default tag table.  

→ Before the visualization is downloaded to the panel, compile the CPU and panel again and 

save the project. (→ Panel KTP700 Basic → → ) 

→ To download the visualization to the panel, select the → "Panel KTP700 Basic [KTP700 

Basic]" folder and click the →  "Download to device" button.  

7.15 Messages 

A couple of alarm windows were already created when you used the wizard to create the Panel 

KTP700 Basic. We will now take a closer look at them. 

 

7.15.1 General alarm settings 

→ The first step is to make several settings for the display of alarms in Runtime. To do this, 

double-click the → "Runtime settings" folder in → "Panel KTP700 Basic". Under "General" in 

"Alarms", select →  "Alarm class colors", and under "System events", change → Display 

duration in seconds to "10". 
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7.15.2 Alarm window 

→ For the alarm windows to be displayed in the foreground in every screen, a → "Global 

screen" is available in the → "Screen management" folder of → "Panel KTP700 Basic". Open 

this with a double-click. Three alarm windows have already been created in this screen. In 

the first alarm window→ "System events",  "Pending alarms" and the alarm class  

"System" are already selected under "General" in "Properties". 

 

 

Note: 

– System events will be automatically displayed in Runtime for ten seconds. 
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→ The → "Pending alarms" alarm window is the second alarm window in the "Global screen" 

screen. Select  "Pending alarms" under "General" in "Properties". Select  "Errors" and  

"Warnings" as alarm classes. 

 

Note: 

– You will create alarm classes of types "Errors" and "Warnings" in the panel itself in 
subsequent steps. 

→ The → "Unacknowledged alarms" alarm window is the third alarm window in the "Global 

screen" screen. Select  "Unacknowledged alarms" under "General" in "Properties". Select 

only  "Errors" here as the alarm classes. 
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7.15.3 Alarm indicator 

→ In addition to the alarm windows, the "Global screen" screen also contains an → "Alarm 

indicator". Its purpose is to display an alarm window again, which the user hid by clicking it 

away. Under "General" in "Properties", select  "Errors: Pending messages",  "Errors: 

Acknowledged" and  "Warnings: Pending alarms" as the message classes. 

 

→ Under → "Events", the "ShowAlarmWindow" function is already entered for the "Click" event. 

Change the → "Object name" for "Click when flashing" to "Alarm window_Unacknowledged" 

so that this alarm window will be opened here. 
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7.15.4 Settings of alarm classes 

→ The → "HMI alarms" menu item is available in → "Panel KTP700 Basic" for configuration of 

the alarm system and creation of customized alarms. Open this with a double-click. The 

alarm classes to be used are already created in the "Alarm classes" menu item. These can 

still be changed, however. For the → "Warnings" alarm class, change the background color 

for the "Incoming" and "Incoming/Outgoing" statuses to → "Yellow". 
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7.15.5 System events 

→ You can have system events automatically imported in the "System events" menu item by 

clicking → "Yes". 

 

 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 116 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

7.15.6 Analog alarms 

→ Tags can be monitored for limits in "Analog alarms". Click "Add" to create a new alarm. For 

monitoring, select the → "SPEED_MOTOR [DB2]" data block in → "CPU_1214C" and drag 

the → "Speed_Actual_Value" tag from the → "Details view" to the "Trigger tag" field. Next, 

drag the → "Positive_Speed_Threshold_Error" tag from the → Details view to the "Limit" 

field. 

 

 

→ Enter the text → "Error threshold exceeded motor pos. speed" in the "Alarm text" column, 

select the "Alarm class" → "Errors" and → "Higher" for mode. Follow the same procedure to 

create the three other alarms of alarm classes "Warnings" and "Errors" shown below. 
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→ The tags relevant for the alarm system must be continuously updated cyclically. 

 For this, open the → "Default tag table" of the panel and select the 

"SPEED_MOTOR_Positive_Speed_Threshold_Error" tag. You can change the →"Acquisition 

mode" under "Settings" in "Properties" to  

→ "Cyclic continuous". Follow the same procedure to change and check the following tags: 

"SPEED_MOTOR_Speed_Actual_Value",   

"SPEED_MOTOR_Positive_Speed_Threshold_Warning", 

"SPEED_MOTOR_Negative_Speed_Threshold_Error" 

"SPEED_MOTOR_Negative_Speed_Threshold_Warning". 
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7.15.7 Discrete alarms 

→ Before you can create discrete alarms in the panel, you need a global tag with at least 16 bits 

in the CPU 1214C, which you will use to trigger the discrete alarms from the PLC. Here, you 

open the → "OPERATING_HMI[DB4]" data block in the → "Program blocks" folder of "CPU 

1214C" and create a global tag → "Group signals01" of data type → "Word". 

 

→ In the → "Program blocks" folder, click → "Add new block" to create  

→ → "Assign_discrete_alarms". 
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→ In the "Assign_discrete_alarms" function, create a local input tag → "discrete_alarm_X0" of 

data type → "Bool" and a local output tag → "group_signals01" of data type → "Word".  

In the first network, program a simple  assignment of the → "discrete_alarm_X0" tag to 

the → "group_signals01" tag. 

 

Note: 

– The "Tag1.%X0" syntax is referred to as slice access in the TIA Portal. This enables, for 
example, bit-by-bit access to a tag of data type Byte, Word or DWord. If you need additional 
information on this, you can search the term "slice" in the STEP 7 online help. 
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→ Next, open the → "Main[OB1]" block in the "Program blocks" folder and call the → 

"Assign_discrete_alarms[FC1]" function → in "Network 4". Connect the input of the 

"Assign_discrete_alarms[FC1]" function with the negated global tag → "-K0" / %I0.1 / System 

"ON" (no) from the "Tag table_Sorting station".  

Connect the output of the "Assign_discrete_alarms[FC1]" function to the global tag → 

"group_signals01" from the "OPERATING_HMI[DB4]" data block. 
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→ Return to → "HMI alarms" → "Discrete alarms" in "Panel KTP700 Basic". Click → "Add" to 

create a new alarm. Select the → "group_signals01" tag you just created from the 

"OPERATING_HMI[DB4]" data block.  

Enter the text → "Main switch OFF" in the "Alarm text" column, select the "Alarm class" → 

"Warnings" and → "0" for "Trigger bit". The "Trigger address" now displays 

"OPERATING_HMI_group_signals01.x0". 

 

 

→ Before the visualization is tested, the "Acquisition cycle" of all newly created tags is to be 

accelerated again from 1 second to 100 milliseconds in the default tag table.  

→ Before the visualization is downloaded to the panel, compile the CPU and panel again and 

save the project. (→ CPU_1214C →  → Panel KTP700 Basic → → ) 

→ After successful compilation, the entire controller with the created program including the 

hardware configuration, as previously described in earlier modules, can be downloaded. 

(→ CPU_1214C → ) 

→ To download the visualization to the panel, follow the same procedure. Select the → 

"Panel KTP700 Basic [KTP700 Basic]" folder and click the →  "Download to device" 

button.  
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→ Analog alarms and discrete alarms will now be automatically displayed in the 

"Pending/Unacknowledged alarms" alarm window and in the "Alarm line" in Runtime. Details 

and help texts can be displayed in the alarm window and alarms can be acknowledged if 

necessary. If the alarm window has been closed, it can be displayed again by clicking the 

displayed alarm indicator. Various alarm classes appear in different colors. 
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7.16 Remote operation of Panel KTP700 Basic 

7.16.1 Activating web services for Runtime 

→ To enable remote control, the → "Runtime settings" must be opened with a double-click in 

the configuration for → Panel KTP700 Basic. Under → "Remote control" in "Services", select 

the →  "Start Sm@rtServer" option. 

 

 

7.16.2 WinCC Internet settings on Panel KTP700 Basic 

→ Settings must also be made directly on the panel. Select → the "Settings" button in the "Start 

Center" immediately after switching on the power supply and starting the panel. 

 

Note: 

– You must select "Settings" in the "Start Center" quickly before Runtime automatically starts. 
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→ Under "Transfer, Network & Internet" click the  icon to navigate to the web server 

settings. 

 

 

→ Select the following settings in the "Sm@rtServer" menu item. 
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→ Under "Security Settings" and "Force Write Access", assign passwords (e.g. "sce") and select 

the settings shown here. 

 

7.16.3 Starting remote access to Panel KTP700 Basic 

→ To use remote access to your panel, you can start the → "Sm@rtClient" tool installed with the 

TIA Portal. 

     
 

→ Enter the IP address of the device → "192.168.0.10" and click on  → "Connect". 
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→ A window indicating the status of the connection is displayed as well as another window 

where you must enter the password you set previously in the panel → "sce" → "OK". 

 

 

 

→ You then have the option of monitoring and operating the panel remotely and even changing 

the settings in Windows CE of the device. 
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7.17 Archiving the project 

→ Finally, you should archive the complete project. Select → "Project" → "Archive …" in the 

menu. Create a folder in which you want to archive your project and save your project as file 

type 'TIA Portal project archive'. (→ Project → Archive … → SCE_EN_041-101 WinCC Basic 

with KTP700 and S7-1200…. → Save) 

 

 



Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 128 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

8 Checklist – step-by-step instruction 

The following checklist helps trainees/students to independently check whether all steps of the 
step-by-step instruction have been carefully completed and enables them to successfully 
complete the module on their own. 

No. Description Checked 

1 Program successfully changed in the CPU 1214C  

2 
Successful compilation of the CPU 1214C without error 
message 

 

3 
Successful download of the CPU 1214C without error 
message 

 

4 
Process visualization successfully created for Touch Panel 
KTP700 Basic 

 

5 
Successful compilation of the Touch Panel KTP700 Basic 
without error message 

 

6 
Successful download of the Touch Panel KTP700 Basic 
without error message 

 

7 

Switch on system (-K0 = 1) 
Cylinder retracted / feedback activated (-B1 = 1) 
EMERGENCY STOP (-A1 = 1) not activated 
AUTOMATIC mode (in panel) 
Automatic stop pushbutton not actuated (-S2 = 1) 
Briefly press the automatic start pushbutton (in panel) 
Sensor part at slide activated (-B4 = 1) 
Conveyor motor -M1 variable speed (-Q3 = 1) turns on and 
remains active 
The speed corresponds to the speed setpoint in the range of 
+/- 50 rpm 

 

8 
Sensor at conveyor end activated (-B7 = 1) → -Q3 = 0  
(after 2 seconds) 

 

9 
Briefly press the automatic stop pushbutton (-S2 = 0 or in 

panel) → -Q3 = 0 
 

10 Activate EMERGENCY STOP (-A1 = 0) → -Q3 = 0  

11 Manual mode (in panel)→ -Q3 = 0  

12 Switch off system (-K0 = 0) → -Q3 = 0  

13 Cylinder not retracted (-B1 = 0) → -Q3 = 0  

14 Speed > Speed limit fault max. → -Q3 = 0  

15 Speed < Speed limit fault min. → -Q3 = 0  

16 Values and alarms are displayed on the panel  

17 Project successfully archived  
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9 Exercise 

9.1 Task description – Exercise  

The following functions are to be added to the process visualization in this exercise: 

The "Overview Sorting Station" overview screen will display the "Setpoint" and "Actual" 
"Plastic" workpieces count. 

The "Speed Motor" screen will display the current speed and speed setpoint of the motor 
graphically and in IO fields. The speed setpoint can also continue to be specified here. 

The error and warning thresholds for positive and negative motor speed are to be displayed and 
set here in IO fields. A red box in front of the IO fields indicates when a limit has been exceeded. 

In the "Magazine Plastic" screen, the "Setpoint" and "Actual" count will be displayed graphically 
and in IO fields. The setpoint for the plastic parts can be specified in the range 0 to 20 in the IO 
field. The counter can also be reset here. 

The emergency stop and the status of automatic mode is also to be monitored in the alarm 
system. If the emergency stop is triggered or automatic mode is stopped, a warning is to be 
displayed. 

 

9.2 Technology schematic diagram 

Here you see the technology schematic diagram for the task. 

 

Figure 5: Technology schematic diagram 

 

Figure 6: Operator panel 
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9.3 Reference table 

The following signals are required as global operands for this task. 

DI Type ID Function NC/NO 

I 0.0 BOOL -A1 Return signal emergency stop ok NC 

I 0.1 BOOL -K0 Main switch "ON" NO 

I 0.2 BOOL -S0 Mode selector manual (0) / automatic (1) 
Manual = 0 

Auto=1 

I 0.3 BOOL -S1 "Automatic start" pushbutton NO 

I 0.4 BOOL -S2 Pushbutton automatic stop NC 

I 0.5 BOOL -B1 Sensor cylinder -M4 retracted NO 

I 1.0 BOOL -B4 Sensor part at slide NO 

I 1.3 BOOL -B7 Sensor part at end of conveyor NO 

IW64 BOOL -B8 
Sensor actual motor speed +/-10V 
corresponds to +/- 50 rpm 

 

 

DO Type ID Function  

Q 0.2 BOOL -Q3 Conveyor motor -M1 variable speed  

QW 64 BOOL -U1 
Motor speed manipulated variable in both 
directions +/-10V corresponds to +/- 50 rpm 

 

 

Legend for reference list 

 

 

 

 

 

 

 

 

 

9.4 Planning 

Plan the implementation of the task by yourself. 

DO Digital output 

AO Analog output 

O Output 

DI Digital input 

AI Analog input 

I Input 

NC Normally Closed 

NO Normally Open 
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9.5 Checklist – Exercise 

The following checklist helps trainees/students to independently check whether all steps of the 
exercise have been carefully completed and enables them to successfully complete the module 
on their own. 

No. Description Checked 

1 Program successfully changed in the CPU 1214C  

2 
Successful compilation of the CPU 1214C without error 
message 

 

3 
Successful download of the CPU 1214C without error 
message 

 

4 
Process visualization successfully created for Touch Panel 
KTP700 Basic 

 

5 
Successful compilation of the Touch Panel KTP700 Basic 
without error message 

 

6 
Successful download of the Touch Panel KTP700 Basic 
without error message 

 

7 

Switch on system (-K0 = 1) 
Cylinder retracted / return signal activated (-B1 = 1) 
EMERGENCY STOP (-A1 = 1) not activated 
AUTOMATIC mode (in panel) 
"Automatic stop" pushbutton not pressed (-S2 = 1) 
Briefly press "Automatic start" pushbutton (in panel) 
Sensor part at slide activated (-B4 = 1) 
Conveyor motor -M1 variable speed (-Q3 = 1) turns on and 
remains active 
The speed corresponds to the speed setpoint in the range of 
+/- 50 rpm 

 

8 
Sensor at conveyor end activated (-B7 = 1) → -Q3 = 0 (after 2 
seconds) 

 

9 
Briefly press "Automatic stop" pushbutton (-S2 = 0 or in panel) 

→ -Q3 = 0 
 

10 Activate EMERGENCY STOP (-A1 = 0) → -Q3 = 0  

11 Manual mode (in panel)→ -Q3 = 0  

12 Switch off system (-K0 = 0) → -Q3 = 0  

13 Cylinder not retracted (-B1 = 0) → -Q3 = 0  

14 Speed > Speed limit fault max. → -Q3 = 0  

15 Speed < Speed limit fault min. → -Q3 = 0  

16 Values and alarms are displayed on the panel  

17 Project successfully archived  
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10 Additional information 

More information for further practice and consolidation is available as orientation, for example, 
Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software / 
firmware, under the following link:  

siemens.com/sce/s7-1200 

 
 
Preview "Additional information"  

 

 

 

http://www.siemens.com/sce/s7-1200


Learn-/Training Document | TIA Portal Module 041-101, Edition 09/2018 | Digital Factory, FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2018. All rights reserved. 133 

041-101-wincc-basic-ktp700-s7-1200-r1709-en.docx 

Further information 

Siemens Automation Cooperates with Education 

siemens.com/sce 

SCE Learn-/Training Documents 

siemens.com/sce/module 

SCE Trainer Packages 

siemens.com/sce/tp 

SCE Contact Partners  

siemens.com/sce/contact 

Digital Enterprise 

siemens.com/digital-enterprise 

Industry 4.0  

siemens.com/future-of-manufacturing 

Totally Integrated Automation (TIA) 

siemens.com/tia 

TIA Portal 

siemens.com/tia-portal 

SIMATIC Controller 

siemens.com/controller 

SIMATIC Technical Documentation  

siemens.com/simatic-docu 

Industry Online Support 

support.industry.siemens.com 

Product catalog and online ordering system Industry Mall  

mall.industry.siemens.com 
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